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Release Notes
RA8000/ESA12000 and MA8000/EMA12000 Solution

Software V8.5c for HP-UX

This document summarizes features and characteristics of the HSG80 Array Controller (Array
Controller Software Version 8.5) for Hewlett Packard systems that are supported in the 8.5c
release of the HSG80 Solution Software for Hewlett Packard platform kit.

These Release Notes provide information not covered elsewhere in the documentation,
and takes precedent over all other sources. Individuals responsible for installing,
configuring, and using the HSG80 Array controller should use this document.

NOTE
Read this entire document before installing or upgrading the software.

WARNING  

In certain configurations there may be difficulties with the software installation
procedure published in the included RA8000/ESA12000 and MA8000/EMA12000

Solution Software V8.5c for HP Installation Reference Guide.

The procedure defined in Section 12 is the preferred method for Solution Software
Kit installation. These instructions take precedence.
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These release notes include the following sections:

1.0 Identifying Your ACS Software Revision Level

2.0 Hardware and Software Support
NOTE

Refer to this section for updates to SWCC
Software revision levels.

3.0 New Features

4.0 Configuration Rules

5.0 Operating Constraints

6.0 Saving Your Configuration

7.0 Host Operating System Notes

8.0 Avoiding Problem Situations

9.0 Using the HSG80 Controller in a Modular Solution

10.0 StorageWorks Command Console

11.0 HSG80 Documentation Additions and Corrections

12.0 Solution Software Kit Installation

Intended Audience

This document has been prepared for customers who have purchased the
RA8000, ESA12000, MA8000, or EMA12000 Fibre Channel storage array with
an HSG80 controller, and for Compaq Customer Services personnel responsible
for installing and maintaining systems that include the HSG80 array controller.

Visit our Web Site for the Latest Information

Check our web for the latest drivers, technical tips and documentation for the
HSG80 Array Controller. We can be found in the technical area of our web page:

http://www.compaq.com/support
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Release Package Contents

The Solution Software Version 8.5c kit consists of the following:

• The HSG80 Solutions documentation set:

-- Modular Array Configuration Guide EK-MACON-CA.A01

-- Compaq StorageWorks Command Console V2.3 User Guide
AA-RFA2F-TE

-- RA8000/ESA12000 and MA8000/EMA12000 HSG80 Array
Controller StorageWorks Solution Software Kit Overview EK-
SOLSR-AA.B01

-- HSG80 Array Controller ACS Version 8.5 Configuration Guide
EK-HSG85-CG.B01

-- HSG80 Array Controller ACS Version 8.5 CLI Reference Manual
EK-HSG85-RG.A01

-- HSG80 Array Controller ACS Version 8.5 Maintenance and Service
Guide EK-HSG84-SV.C01

-- Registration
RA7000/8000, ESA10000/12000 and MA8000/EMA12000
EK-RAESA-RC.D01

-- StorageWorks Warranty Package
Warranty Terms and Conditions EK-HSXSW-WC.C01
Warranty Terms and Conditions Addendum 3R-Q178A-3V.B01
158199-021

-- RA8000/ESA12000 and MA8000/EMA12000 Solution Software
V8.5c for HP Installation Reference Guide AA-RFBEF-TE

• RA/MA8000 ESA/EMA12000 Solution Software V8.5c for Hewlett
Packard CD-ROM
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1.0 IDENTIFYING YOUR ACS SOFTWARE REVISION LEVEL

You can identify ACS Software Version 8.5 by entering the following command
at the CLI prompt:

 SHOW THIS_CONTROLLER

The resulting display lists the software revision level as the following:
 V8.5F-0

 2.0 HARDWARE AND SOFTWARE SUPPORT

2.1 Operating System Support

This section lists the hardware and software supported by ACS Version 8.5 for
the 8.5c HP-UX kit release.

 Table 1. Minimum System Requirements

 Host Feature  Requirement

 Platform  HP9000 Series K-Class, Models 2xx, 3xx, 4xx, and 5xx

 HP9000 Series D-Class, Models 2xx, 3xx

 HP 9000 Series L-Class, Model 2000

 HP 9000 Series N-Class, Model N4xxx

      HP 9000 Series T-Class, Model T6xx

 HP 9000 Series V-Class, Model V2xxx

 Operating System  HP-UX Versions 10.20 and 11.0

 Fibre Channel Adapter
Compatibility

 HP A3404A, HP A3591A, HP A3591B, HP A3636A, HP A3740A,
HP A5158A, 218409-B21 (Compaq/QLA2200)

 Notes:

 Only Two 218409-B21 (Compaq/QLA2200) FC HBAs per PCI bus
carrier are supported on HP V-Class Systems.

 The 218409-B21 and HP (PCI) FC HBAs are not supported on the
same PCI bus.

 The 218409-B21 HBA is only supported on L, N and V Series
servers running HP-UX 11.00.

 The 218409-B21 HBA does not support Compaq Enterprise
Backup Systems (EBS) tape drives in a fabric environment.

 FC-SW connectivity is not supported with the HP A5158A FC
Adapter

 Controller Compatibility  HSG80 Array Controller operating firmware ACS Version 8.5
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2.2 Device Support

ACS Software Version 8.5 supports the devices listed in the Table 2 below at the
indicated hardware levels.

Table 2. Supported Disk Drives

Device
Capacity in
Gigabytes

Spindle
Speed
(RPM)

Minimum
Microcode
Version

Minimum
Hardware
Version

DS-RZ1CB-VW 4.3 7,200 LYJ0 or 0656 A01
DS-RZ1CD-VW 4.3 10,000 0306 A01
DS-RZ1DB-VW 9.1 7,200 LYJ0 or 0307 A01
DS-RZ1DF-VW 380595-B21 9.1 7,200 N1H1, 0372,

or 1614
A01

DS-RZ1DD-VW 380588-B21 9.1 10,000 0306 A01
DS-RZ1EF-VW 380694-B21 18.2 7,200 N1H1 or 0372 A01
DS-RZ1ED-VW 380589-B21 18 10,000 0306 A01
DS-RZ1DA-VW 147497-001 9 7,200 3B05 A01
DS-RZ1EA-VW 147598-001 18 7,200 3B05 A01
DS-RZ1FB-VW 147599-001 36 7,200 3B06 A01

123065-B22   BB00911CA0 9.1 7,200 3B05 A01

388144-B22   BB01811C9C 18.2 7,200 3B05 A01

128418-B22   BD018122C9 18.2 10,000 B016 A01

328939-B22   BD009122BA 9.1 10,000 3B07 A01

188120-B22   BF00963643 18.2 15000 3B01 A01

188122-B22   BF01863644 18.2 15000 3B01 A01

176496-B22   BD03663622
BD0366349C
BD036635C5

36.4 10,000 BDC4
3B01
B012

A01
A01
A05

176494-B21   BC072638A2 72.8 10,000 BDC4/BDC7 A01
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2.3 StorageWorks Command Console

The StorageWorks Command Console (SWCC) version 2.3 is included in this
release. SWCC provides a graphical user interface that can be used to configure
and monitor your storage subsystem.

Use of SWCC is highly recommended, but not required. The SWCC Agent is
installed as part of the CPQhsg80 package. Refer to the RA8000/ESA12000 and
MA8000/EMA12000 Solution Software V8.5c for HP Installation Reference
Guide for information about installing the solution software packages.

SWCC contains an on-line manual, which can be accessed in the on-line Help.
For the latest information about SWCC refer to the product links available on the
Compaq web site at:

http://www.compaq.com/products/storageworks/

 
 NOTE

 Due to problems found with the A28696A
HPPB SCSI adapter on HP systems during
the qualification of SWCC agent version 2.3,
this release of SWCC version 2.3 will not
include support for this adapter.

 When the problem involving this adapter is
resolved, a new copy of the agent will be
made available on the Compaq Storage web
site.
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2.3.1 Identifying Your SWCC Software Revision

The StorageWorks Command Console Client software suite for the HSG80 V8.5
consists of various components. The following SWCC components are included
in this release of the Solution Software kit:

SWCC Command Console (storage window manager) V2.2.0.213
SWCC CLI Window V2.0.0.33
HSG80ACS85 StorageWindow V2.3.0.13
HSG80 StorageWindow V2.1.0.28
HSZ StorageWindow V2.3.0.47
HSZ80 StorageWindow V2.3.0.15
HSD StorageWindow V2.0.0.5
HSJ StorageWindow V2.0.0.5

Verification of the individual components can be done with Explorer by right-
clicking on the particular executable program in its folder and selecting the
Properties option. In the resulting Properties window, click on the Version tab
and select the Product Version to display the version of the program

2.3.2 SWCC Manual Refresh Rate

We recommend that you do not refresh SWCC windows more often than once
every 30 seconds.

2.3.3 Storage Area Network (SAN) Configuration

In a SAN configuration, only one SWCC Agent should be active at one time.

 3.0 NEW FEATURES

This section briefly describes features that are supported by the HSG80
controller. For more information on these features, see the HSG80 Array
Controller ACS Version 8.5 Configuration Guide and the HSG80 Array
Controller ACS Version 8.5 CLI Reference Manual.

3.1 External Cache Battery

Compaq recommends that you replace the ECB every two years to prevent
battery failure.
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If you are shutting down your controller for longer than one day, complete the
additional steps in “Shutting Down the Subsystem” in the HSG80 Array
Controller ACS Version 8.5 Maintenance and Service Guide. This will prevent
the ECB from discharging during planned power outages.

3.2 CLI Commands

ADD CONNECTIONS and SET CONNECTIONS now support the following
Operating Systems:

TRU64_UNIX
IBM
SUN
VMS
WIN NT
SGI
HP
NOVELL NetWare

3.3 218409-B21 (Compaq/QLA2200) HBA and FC-SW Support

This version of the StorageWorks 8.5c Solution Kit now supports SAN (Fibre
Channel) Switches F-port connectivity through the use of the 218409-B21 HBA
and Compaq v2.5.8 HBA driver, and up to 64 units per HSG80 controller.

4.0 CONFIGURATION RULES

The following list outlines the configuration rules for the controller:

Maximum 128 visible LUNs/200 assignable unit numbers
Maximum 512 GB LUN capacity
Maximum 72 physical devices
Maximum 20 RAID-5 storagesets
Maximum 30 RAID-5 and RAID-1 storagesets
Maximum 45 RAID-5, RAID-1, and RAID-0 storagesets
Maximum 8 partitions of a storageset or individual disk
Maximum 6 members per mirrorset
Maximum 14 members per RAID-5 storageset
Maximum 24 members per Stripeset
Maximum 48 physical devices per striped mirrorset
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5.0 OPERATING CONSTRAINTS

This section describes the operating constraints for ACS Software Version 8.5.
An operating constraint is a limitation placed on the operation of the controller.

5.1 Using FRUTIL to Insert a New Controller

When using FRUTIL to insert a new controller in a dual-redundant controller
configuration, the user will see a new set of instructions after the new controller
has been inserted:

If the other controller did not restart, follow these steps:

1. Press and hold the other controller’s reset button.

2. Insert the other controller’s program card.

3. Release the reset button.

 NOTE

 Be aware that running FRUTIL will quiesce
all I/O. Consequently, never run this
program when under heavy load.

5.2 Dual External Cache Battery Failures

The HSG80 Array Controller cache policy provides for proper handling of a
single ECB failure as described in Table 2-8 of the HSG80 Array Controller
ACS Version 8.5 Configuration Guide and in the HSG80 Array Controller ACS
Version 8.5 CLI Reference Manual.  For dual ECB failures, Table 2-8 states that
no failover occurs. For this release, if a dual ECB failure is detected both
controllers will be restarted.
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 6.0 SAVING YOUR CONFIGURATION

6.1 Saving a Configuration to Previously Initialized Storagesets

When enabled, the SAVE_CONFIGURATION switch allows you to do the
following on single-controller configurations only:

Save a configuration to a disk or storageset. The configuration may be retrieved
later and downloaded onto a replacement controller.

Retain code patches to the operating software.

If any storageset within your configuration was previously initialized with the
INITIALIZE container-name SAVE_CONFIGURATION command to save your
configuration to disk, it will not be necessary to reconfigure your devices with a
new controller. SAVE_CONFIGURATION also retains code patch information
to the software. This option is supported on single controller configurations only.

ACS Software Version 8.5 saves any installed software patches on disks
initialized with the SAVE_CONFIGURATION option. Should you need to
replace a controller and restore the configuration from a disk, you will not have
to reinstall any software patches.

 NOTE

 You must use the same software version
when replacing the controller. You can also
hold in port button 6 on the operator control
panel, and press the reset button to restore
the configuration.

Configuration information cannot be retrieved from storagesets created on other
HSx controllers (for example, HSD, HSJ, or HSZ controllers). You can only
restore a configuration from a configuration saved on this or another HSG80
array controller.

 7.0 HOST OPERATING SYSTEM NOTES

7.1 StorageWorks Command Console (SWCC) Version 2.3

This version of StorageWorks Solutions Software includes the StorageWorks
Command Console (SWCC) Version 2.3 Client and Agent programs. SWCC
may be used to configure and monitor storage subsystems attached to SGI, IBM,
SUN, HP and DIGITAL UNIX systems. Refer to Section 10.0 for SWCC related
notes.
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7.2 HP-UX Bootability

Using the HSG80 array controller running on ACS 8.5, HP-UX bootability is not
supported.

7.3 Configuring the HP-UX File System

Adding the RAID Storageset to Volume Groups:

 CAUTION

 When using HP Fibre Channel Host Bus
Adapters only:

 Do not use SAM to create Volume Groups.
Creating volume groups must be
accomplished using HP-UX commands.

This is because, when SAM scans the hardware, any HSG80 controller LUNs
created after the first LUN are not parsed correctly and consequently cannot be
selected to create a volume group. The solution around this problem is to use
HP-UX commands to create the Volume Groups and then use SAM to create and
manage Logical Volumes. For additional details, refer to Chapter 3 of the
RA8000/ESA12000 and MA8000/EMA12000 Solution Software V8.5c for HP
Installation Reference Guide.

 8.0 AVOIDING PROBLEM SITUATIONS

Under certain conditions, you may experience unusual controller behavior. This
section presents information to help you avoid such situations and to recover
from them if they occur.

8.1 Adding, Moving, and Changing Devices

The controller maintains a configuration map of a device’s type and location.
This map is used to communicate with devices. If you add, move, or change a
device while the controller is powered off without first changing the controller
configuration, the controller is not able to communicate with the changed device
when it returns to service.

If a device is removed by mistake while the controller is off, delete all containers
associated with the removed device after power has been restored to the
controller.
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If a device is replaced while the controller is off, remove the device before
restoring power to the controller. Correctly remove the current device and add
the new device after restoring power to the controller.

See the HSG80 Array Controller ACS Version 8.5 Maintenance and Service
Guide for correct device removal and addition procedures.

8.2 Moving Storagesets

Move only normal storagesets. Do not move storagesets that are reconstructing
or reduced, or data corruption will result.

8.3 Adding, Moving, and Changing Controllers, Cache Modules,
or External Cache Batteries

It is permissible to replace the controller, cache module, or external cache battery
while the subsystem is shut down. However, you must enter the SHUTDOWN
THIS_CONTROLLER command before shutting the subsystem down to make
configuration changes. If two controllers are configured in a dual-redundant
configuration, you must first enter the SHUTDOWN OTHER_CONTROLLER
command.

These commands instruct the controllers to flush all unwritten data from the
cache modules and discontinue all I/O activity. For more information regarding
the SET controller command or maintenance and replacement of the controller,
cache module, and external cache battery, see the HSG80 Array Controller ACS
Version 8.5 Configuration Guide and the HSG80 Array Controller ACS Version
8.5 CLI Reference Manual.

If the first attempt to establish a SWCC SCSI or serial direct connection fails, try
making the connection again.

8.4 Establishing a SCSI Direct Connection

Establishing a SCSI direct connection lists all available drives, including the
system drive. You must select a drive that belongs to the HSG80 controller,
otherwise the connection will fail.

SCSI Direct Connection is not supported on HP platforms.
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9.0 USING THE HSG80 CONTROLLER IN A MODULAR SOLUTION

The modular solution consists of the HSG80 controller (single or dual
configurations) installed in a Model 2200 UltraSCSI Enclosure and the drives
installed in either a Model 4214R disk enclosure or a Model 4254 disk
enclosure. The modular solutions must be mounted in RETMA cabinets. The
RETMA cabinets are available in heights of 42U, 41U, 36U and 22U. The
Model 2200 enclosure is 4U. The Model 4214R disk enclosure and the Model
4254 disk enclosure are each 3U. This combination allows for several cabinet
configurations.

NOTE

If you wish to use an existing HSG80
controller, it will require the Cache Bulkhead
upgrade for installation of the HSG80 in the
Model 2200.

For information on how to install HSG80 controllers in Model 2200 UltraSCSI
Enclosures, see the Compaq StorageWorks Model 2200-series Enclosure User
Guide.

For information on how to install drives in either a Model 4214 disk enclosure or
a Model 4254 disk enclosure, see the Compaq StorageWorks Enclosure 4200
Family LVD Disk Enclosure User Guide.

For information on the 9000-series, see the Compaq 9000 Series Rack Products
Reference Guide.

9.1 Disk Enclosures

The HSG80 controller firmware can address up to 12 disks per SCSI bus.  In
single bus mode this means that 12 of the 14 disks in models 4214R and 4254
are used. The 2 extra disks can be used for in-cab inventory. The firmware can
see seven disks on each bus allowing use of all 14 when configured for dual-bus
mode. The maximum number of disks supported by an HSG80 (single or
cooperating pair) is 72.  The disk enclosures can be configured for single bus or
for dual bus.

NOTE

The 42xx disk enclosures do not allow
daisy chaining between shelves.
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9.1.1 Single-Bus Mode

Disk Enclosures Options/Single Bus Mode Part Number

StorageWorks Enclosure Model 4214 R 103381-001, B31, 291
(Rack Mountable Single Bus Single Power 14 Bay Drive Shelf)

Second Power Supply for 4214R 119826-B21
(Adds a redundant power supply to the 4214R)

Dual Bus I/O Module for Existing 4214R 119829-B21
(Changes the 4214R from a single bus to a dual bus)

NOTE

4214Rs shipped prior to February 28, 2000,
may require the exchange of the EMU and
single bus modules to operate properly with
the HSG80. Check the EMU and I/O
modules: if you see a “FB” sticker the
modules are appropriate for the HSG80. If
there is no sticker contact your local service
representative.

9.1.2 Dual-Bus Mode

Disk Enclosures Options/Dual Bus Mode Part Number

StorageWorks Enclosure Model 4254 138151-001, B31, 291
(The 4254 includes the redundant power supply and the dual bus I/O module.)

There is no option available to transform a Model 4254 disk enclosure to single
bus.

9.1.3 SCSI Cables

SCSI Cables must be ordered separately for connection of the 42xx shelves to
the Model 2200 enclosure.

SCSI Cable Options                                                           Part Number
1M SCSI Cable 168256-B21

2M SCSI Cable 168258-B21

3M SCSI Cable 189505-B21
5M SCSI Cable 400983-005
10M SCSI Cable 400983-010
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9.2 Modular Solution

The Modular Array/Enterprise Modular Array storage systems can be ordered
three ways.

Predefined models are available that provide a set number of controller shelves
and drive shelves in a Modular Storage Cabinet:

MA8000: One Model 2200 controller enclosure and three dual-bus Model 4254
disk enclosures in a 22U Modular Storage Cabinet

EMA12000 D14: Three Model 2200 controller enclosure and nine dual-bus
Model 4254 disk enclosures in a 42U Modular Storage Cabinet

EMA12000 S14: One Model 2200 controller enclosure and six single-bus Model
4214R disk enclosures in a 36U Modular Storage Cabinet

EMA12000 Blue: One Model 2200 controller enclosure and three dual-bus
Model 4254 disk enclosures in a 41U Modular Storage Cabinet

 NOTE

 The predefined models require the following
options: Controllers, Controller firmware and
drives.

Configure-to-Order: This allows you to specify the number of controller shelves
and drive shelves desired in a Modular Storage Cabinet.

Assembly on site: This allows you to order the components separately and install
them in any supported RETMA rack or cabinet.
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 10.0 STORAGEWORKS COMMAND CONSOLE V2.3

This portion of the release notes provides application information on Version 2.3
of Command Console HSG80 Client software. Command Console HSG80
Client 2.3 is a feature-rich graphical user interface (GUI) for StorageWorks
HSG80, fibre channel controllers. This document covers the Command Console
HSG80 Client 2.3 Storage and CLI Window modules.

Note that Logical View is an accurate representation of your subsystem;
however, the physical view may not be an accurate representation of your
subsystem.

If you plan to use the SWCC with a Fibre Channel switch and the HSG80
controller, first install the SWCC that came with the switch and then install the
SWCC that came with the HSG80 controller.

This section of the release notes covers the Command Console Storage Manager
and CLI Window modules. These modules are referred to within as “Client”.

10.1 Product Description

Command Console HSG80 Client 2.3 is a standalone or plug-in GUI for HSG80
controller-based storage subsystems. It does not operate with other subsystem
types.

Command Console contains two main components–Client and Agent. For most
versions of Command Console, Client includes the following components:

Navigation Tree—The enterprise storage management window, from which you
can open multiple Storage Windows. Client can be shipped with or without the
Navigation Tree component, depending upon the application of the product.

Storage Window—The graphical window into a specific storage subsystem.
There is a separate Storage Window type for each controller type to be managed.
You must open a separate Storage Window for each subsystem you wish to
manage.

CLI Window—The text-based, command-line window into a specific storage
subsystem, from which you can manage the subsystem using CLI commands.
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10.2 Document Issues

10.2.1 More Information

 For complete product information on StorageWorks Command Console, see the
product’s on-line Help. Also, for details on the features of the controller
software, see the controller documentation.

10.2.2 Installation Notes

Be careful about the order in which you install certain SWCC products. If you
install SWCC from a Switch CD-ROM kit, it may overwrite newer SWCC
components that have been installed with the CD-ROM that ships with this kit.
You should reinstall using the CD-ROM in this kit to ensure that you have the
latest client versions.

Stand-Alone Installations

After doing a stand-alone install of a device-specific Client, exit Command
Console before adding or accessing a system with that type of device. Command
Console will then recognize the installation

SWCC 1.1B Client Will Not Work if Version 2.x Client Was Already
Installed

SWCC 1.1b will malfunction if you already have SWCC 2.x on a
Windows NT/Windows 2000 operating system. The Asynchronous Event
Service that comes with SWCC 2.x uses the same port as SWCC 1.1b. SWCC
1.1b can be removed without impacting SWCC.

Perform the following to solve this:

Uninstall SWCC 1.1b. Ignore the error box that appears.

Reboot the computer. The integration for SWCC 1.1b will have been removed.
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"There is no disk in the drive" Message

When you install the Command Console Client, the software checks the
shortcuts on the desktop and in the Start menu. If you have Windows NT or
Windows 2000, the installation will check the shortcuts of all users for that
computer, even if they are not currently logged on. You may receive an error
message if any of these shortcuts point to empty floppy drives, empty CD-ROM
drives, or removable disks that are no longer present. Do the following:

Ignore the error message by clicking Ignore.

Replace the removable disks, and place a disk in the floppy drive and a
CD-ROM in the CD-ROM drive. Then, click Retry.

10.3 Uninstall Notes

Command Console Client Uninstall Does Not Remove AsyncEventService
Entries

Before uninstalling the Command Console Client, first remove the
AsyncEventService entries. This prevents the computer from sending you
messages during boot time about a service failing to start.

Under Windows NT/Windows 2000, change to the directory to which you
installed the Command Console Client, type the following command and then
press RETURN:

AsyncEventService -remove

Then, remove the Command Console Client.

10.4 Clarifications

This section presents clarifications on the behavior of the software in certain
situations.

SWCC provides generic physical views of modular storage components
(MA8000, MA12000). These views may not exactly match the actual
configuration that you have. Take care in interpreting the shelf position in the
physical view when determining your actual shelf location
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Integration Problems with SWCC and Insight Manager

Starting with Insight Manager version 4.23, the HSG80 controller can be
monitored and managed from Insight Manager. Insight Manager includes the
HSG80 controller and its status on the Insight Manager storage display. Insight
Manager can also launch the SWCC HSG80 Storage Window to manage storage
connected to the HSG80 controller.

When the HSG80 Storage Window is opened within Insight Manager, the
Storage Window that supports ACS version 8.4 and earlier is launched. The
Storage Window will work correctly as long as it is used with HSG80 controllers
that have ACS 8.4 or earlier. The HSG80 Storage Window that opens within
Insight Manager does not support ACS 8.5 or later. Undesirable results may
occur if this Storage Window is used with HSG80 controllers that have ACS 8.5
or later.

SWCC Agent Uninstall

The Windows NT or Windows 2000 SWCC Agent may not be completely
uninstalled (that is, the service is not removed) until a system reboots.

Duplicate Client Entries

Duplicate client entries may appear in the Windows NT or Windows 2000 Start
menu. The extra shortcuts can be removed as follows:

Click Start>Settings>Taskbar.

Click Start Menu>Programs.

Click Advanced.

Click Program folder.

Click Command Console folder.

Remove duplicate entries manually from this folder.
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EMU Status

The EMU status indicators do not reflect the proper status in modular storage
(MA8000, EMA120000). "CLI show EMU" gets "ERROR C000 EMU not
installed or operational" when it may be working correctly.

Event Logs

The event log on the Windows NT or Windows 2000 client may have extra error
message text appended.

Cautions when configuring from a Configuration File

When reconfiguring a storage subsystem from a configuration file, the program
prompts you to choose whether or not the program initializes your virtual disks.
You must choose the appropriate option or you risk the loss of your data as the
configuration file is loaded and your subsystem is reconfigured.

Do not initialize virtual disks—Choose this option when your virtual disks
contain valuable user data, and you wish to retain that data. You might, for
instance, need to replace a failed subsystem component such as a controller or
cache module. In this case, your subsystem configuration must be transferred to
the new hardware, but you do not wish to change any information on your
storage devices themselves.

Initialize virtual disks—Choose this option when your virtual disks do not
contain user data, or when you do not care if the data on them is lost. You might
use this option when configuring a storage subsystem from scratch, to make it
match the configuration in your configuration file.

Virtual Disk Recovery from a Configuration File

Note that when you delete a virtual disk, the disk’s member drives are all
reinitialized and any user data is lost. You cannot restore the virtual disk’s data
by reconfiguring your subsystem from a configuration file. A configuration file
contains only information about the structure of a virtual disk and does not
contain the disk’s data itself.

Warning Message Windows

The controller software responds to problems in parsing and executing
commands from Client and Agent by returning a message window entitled
“Warning”. The content of such messages may contain such indications as
“Command Execution Error,” along with pertinent detailed information.

These messages are simply passed through for display by Client and Agent and
are normally associated with problems in the controller.  However, sometimes
“Command Execution Error” does indicate a problem with SWCC.
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Virtual Disk Maximum Capacity

The maximum capacity of RAID-based virtual disks is determined by the
capacity of the smallest member, not the largest.

The maximum capacity of RAID 0 virtual disks is equal to the number of
members times the capacity of the smallest member.

The maximum capacity of RAID 1 virtual disks is equal to the capacity of the
smallest member.

The maximum capacity of RAID 0+1 virtual disks is equal to the number of
members in one stripe, times the capacity of the smallest mirrorset member.

The maximum capacity of RAID 3/5 virtual disks is equal to the number of
members minus one times the capacity of the smallest member.

Local Client/Agent Network Connection

To create a local connection to take advantage of Agent’s event notification
features, you can run both Client and Agent on the same Windows NT host
machine and connect them using a network connection. No special installation
instructions are necessary to implement this type of connection. Install each
component as if Client were to run on a system remote from the host machine.

Note that, because Client only runs on Windows NT and Windows 2000
systems, and Agent runs on Windows NT, UNIX-based systems, and OpenVMS,
you can only implement this type of connection on a Windows NT system.

Note also that you cannot use Client with a local connection of either type while
an Agent is running on the local machine.

Operating System Considerations

Client provides a graphical interface that replaces your controller’s CLI interface.
It cannot, however, perform all operating system configurations necessary to
make your subsystem’s virtual disks visible to the user in the operating system.

When you create or delete virtual disks using either the CLI or Client, you are
adding or removing “disks” in the subsystem in a manner similar to plugging or
unplugging physical disk drives on the host bus. In either case, there are certain
operating system configuration actions you must perform to make these “disks”
visible or invisible to the operating system’s file system.
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Windows NT/Windows 2000 Configuration

On a Windows NT/Windows 2000 host, after you create or delete a virtual disk
using Client (or the CLI), you must perform the following steps to properly
configure the file system to recognize your changes.

Boot the host system. This action has the effect of forcing the Disk
Administrator to recognize added virtual disks as raw disks, available for use. It
also notes that deleted virtual disks are no longer present.

Create file system partitions on your disks. When you create a virtual disk in the
controller, you have the option to partition it at the controller level in any way
you wish, as long as you create at least one partition per disk. Each of the
controller-level partitions you create becomes a virtual disk, visible to the host.
In Disk Administrator, you must partition these newly added virtual disks at
NT’s file system (NTFS) level.

Once you have partitioned your drives in Windows NT/Windows 2000, the file
system assigns each drive a unique drive letter. Make a note of the drive letters
assigned.

Format your disks—You must format each newly added disk.

Start the Agent Configurator by double clicking its icon in the Command
Console Start Menu group.

Navigate through the menus until a popup appears, prompting you to rescan your
subsystems. Click Yes to perform the rescan and display a list of subsystems.

Make sure that the access device you’ve been using for your subsystem still
exists. If you inadvertently deleted it, you must assign another device in its
place. If no access device exists, Client cannot communicate with your
subsystem unless the CCL is used.

Click the Next button until you can exit the configurator.

Select the Services option in the Windows Control Panel.

Scroll down to highlight the Steam entry.

Click the Stop button and wait for a prompt indicating that the service is halted.

Click the Start button and wait for a prompt indicating that the service is started.

Exit Control Panel.

Windows NT/Windows 2000 now recognizes any changes you may have made
in your virtual disk configuration.
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UNIX-Based Configuration

On a UNIX-based host and after you create or delete a virtual disk using Client
(or the CLI), you must perform the following steps to properly configure the
UNIX file system to recognize your changes.

Reboot the host system—This action has the effect of forcing the file system to
recognize added virtual disks as raw disks, available for use. It also notes that
deleted virtual disks are no longer present.

(Optional) Create file system partitions on your disks—When you create a
virtual disk in the controller, you have the option to partition it at the controller
level in any way you wish. Each of the controller-level partitions you create
becomes a virtual disk, visible to the host.

Afterward, if you desire, you can partition these newly added virtual disks at
UNIX’s file system level. Use the appropriate commands for your operating
system version to perform this task. Once you have partitioned your drives in
UNIX, the file system assigns each drive a unique drive identifier.

Stop and Restart the Agent—Using the Agent configuration script, you must
stop and restart the Agent running on your UNIX host, using the configuration
program. In the program, you must choose the option to create a new storage.ini
file. This action updates the Agent to recognize any virtual disk changes you
have made.

Enabling Subsystems in Windows 2000 Agent Configurator

In the Step 3 dialogue box of the Windows 2000 Agent Configurator, a check
box entitled “Subsystem Enabled” has been added. If this box is not checked, the
program configures the storage.ini file such that the subsystem selected in the
dialogue box is invisible to the host. If the box is checked, the subsystem is
visible. The default state for all subsystems is “enabled.”

Case Sensitivity in Client, Host, and Storage Subsystem Names

In configuring Command Console for network operation, you must enter names
or IP addresses to identify your hosts, storage subsystems, and Client systems. If
you use names (as opposed to IP addresses) the names in Client and Agent must
be consistent to allow the programs to communicate with each other. This
section discusses issues of case sensitivity associated with name entry in Client
and Agent. This information does not apply when you use IP addresses.

In the connection dialogues in Client, you are required to enter host names, and
you also have the option to enter specific storage subsystem names. In the Agent
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installation and configuration programs, you are required to enter Client and
storage subsystem names.

Host and Subsystem Names in Client

Enter host and subsystem names in Client without regard to case.

Subsystem Names in Agent Installation/Configuration Programs

Enter subsystem names in the Agent installation/configuration programs without
regard to case.

Client Names in Agent Installation/Configuration Programs

For Windows NT/Windows 2000 and UNIX-based Agents:
Enter Client names in the installation/configuration programs without regard to
case.

ServerWORKS Connections

You can manually configure any Agent to send SNMP traps to a host running
Compaq Computer Corporation’s ServerWORKS by editing the client.ini file.
Edit the file to include the ServerWORKS host name and SNMP notification.

Running Client via Network Connections

You can operate Client over PPP, SLIP, or RAS network connections. Be aware
though, that some restrictions on features exist. See Operating Constraints.

Display in VGA Mode

There are numerous issues involving the use of Client on a system with standard,
VGA resolution. The Storage window requires a minimum amount of screen
space to properly display its contents. When you use VGA display resolution,
screen space becomes more limited. It is highly recommended that you use
Client with a minimum of SVGA (800x600) display resolution.

If you must use VGA resolution, consider the following suggestions:

You may not be able to see the scroll bars on the bottom of the display. You can
use the Storage window’s menu settings to remove the toolbar from the display
to make room for the bottom scroll bars.

If you are using Client with a 24-device, high-availability enclosure, it may be
easier to configure the subsystem if you set the system type to Generic for
configuration purposes. Return the setting to High-Availability 24-Device
Pedestal for monitoring and viewing.

Tuning Fault Notification
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For faster fault notification, remove any unused host system names in the
client.ini file for each of your Agent programs. Inactive systems may force
timeouts that slow Client response to your commands.

Also, ensure that you are not using event notification while using RAS
connections. See “Delayed Event Notification on RAS Connections” in the next
section, for more details.

Paging and Event Logging Continues After Client is Terminated

In certain situations, you may experience continuing paging and event logging in
response to subsystem faults, even though Client is not running. This behavior is
normal and is a result of paging and event logging activity started by Client
when it was running.

Client’s Asynchronous Event Service (AES) module runs as a Service, and
continues to run, even after Client itself has terminated. The AES module
communicates with Agents whenever it is running, and activates paging and
event logging when a subsystem event occurs.

In Windows NT or Windows 2000, to terminate paging and event logging after
Client has been closed, go to the Services section of Control Panel, select the
“AsyncEventSvc” Service, and stop it.

Setting Up Pager Notification

You may need to tune the pager notification feature for proper functioning with
certain pager systems. The pager feature supports both alphanumeric and
numeric pagers and allows for notification of multiple pagers. You can select
multiple pagers to be notified for multiple storage subsystems within different
blocks of time. You can also temporarily disable any pager.

Use the following procedure to set up and tune the pager notification system:

In Storage Window Manager, select Options>Event Notification>User Profile.

Click on New and enter the name of the person to be notified.

Select the Pager folder and enter the person’s pager number, along with any
prefixes required to reach the outside phone system. It is good practice to place
delays as commas (,) after any exchange switch that might occur. Each comma
results in two seconds of delay. An example is: 8,,1, 800,5551212. In this
example, there is a 4-second delay between the 8 and the 1.

Select the Alphanumeric box if the paging system supports it. Leaving the box
blank results in numeric paging only.

Click on the Enabled box to enable paging to this person.
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Enter the start and end times that this person is available for paging. If you want
24 hour coverage, enter a start time of 0:00 and an end time of 24:00. You must
enter a time period for paging. Leaving the start and end times at 0:00 has the
effect of canceling paging for this person.

Close the User Profile menu.

Select Options/ Event Notification/Notification List, to list all of the persons to
be notified as a named group. (Later, you will be able to assign these groups to
individual systems.) You can enter a description along with the name to state
such information as times and subsystems that this person supports.

If you’re using numeric paging, you can view the failure codes that are used
under Options>Event Notification>Pager codes.

To set the communications port and baud rate for the pager modem, select
Options>Preferences to view the Event Notification Preferences menu. You can
also set the subsystem polling interval on this menu.

You can establish paging on three separate levels: You can establish paging on
all levels on any combination of levels.

a) My Enterprise – Notifies all notifications list listed here for problems on all
systems and subsystems

b) Highlight “My Enterprise” in the Storage Window Manager and then select
/File/Properties/Event Notification from the menu. Clicking on the
Notification List box will list all of the lists you have created. Choice the list
for persons that should be notified in case of a failure on any system.

c) System Level – Notifies all notifications lists listed here for problems on the
specific system and all its subsystems selected

Highlight the desired system name in the Storage Window Manager and then
select Start>Programs>File>Properties>Event Notification. Clicking on the
Notification List box will list all of the lists you have created. Choose the list for
persons that should be notified in case of a failure on any subsystem of this
specific system.

Subsystem Level - Notifies all notification lists listed here for problems on the
specific subsystem selected
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Highlight the desired subsystem name in the Storage Window Manager and then
select Start>Programs>File>Properties>Event Notification. Clicking on the
Notification List box will list all of the lists you have created. Choose the list for
persons that should be notified in case of a failure on this specific subsystem.

You have completed the paging notification setup. You may find that you will
have to make modifications in order to work with various paging systems
throughout the world.

Operating Parameters of Partition Virtual disks

Keep in mind that virtual disks based on partitions on any container are all
closely related. They all share the same target and operating parameters of the
container. If you change any of this information for one partition on the
container, it automatically changes for all the partitions on that container.

10.5 Operating Constraints

This section describes the operating constraints for the software.  An operating
constraint is a limitation placed on the operation of the controller by the nature of
its design.  Keep these constraints in mind, to avoid problems and to help you to
get the maximum performance from your controller.

Compatibility among Product Versions

CAUTION

Pay particular attention to the instructions
below for uninstalling existing Client and
Agent components from your local system.
Failure to remove existing components
before installation may result in Windows
Registry corruption.

Version 2.3 software components are not compatible with version 1.1
components, and operation with mixed components is not supported. You must
uninstall your version 1.X software, including Clients and Agents, before you
install version 2.3 components. Use the instructions that came with your version
1.x software to uninstall it.
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Before you install your new Client software, you must uninstall any existing
version 2.1 CLI Window. Use the “Add/Remove Programs” feature or the
instructions that came with your existing software to uninstall it. The installation
program will install a newer CLI Window version in your old version’s place.

Note that, in configurations with existing version 2.x components, you need not
remove the Storage Window Manager components. You also need not remove
any Storage Window components other than one matching the one you wish to
install. The installation program will install your new Client Storage and CLI
Windows seamlessly under your existing Storage Window Manager.

Failover Mode Set in CLI

Client is intended to be used to configure and monitor your storage only, and
there are some functions available in the CLI that are not available in graphic
form in the GUI. If you wish to use your controller’s multiple-bus failover mode,
you must enable and control that function via the CLI.

Also, if you wish to use virtual disk preferencing in multiple-bus failover mode,
you must set your virtual disk preferences via the CLI when you set the failover
mode.

10.6 Connection Limitations

Local SCSI or serial connections are only available with standalone Storage
Windows. You cannot use the Storage Window Manager to connect locally to a
subsystem.

Some Features Dependent upon Connection Type

Because of the nature of the connections you can use between Client and your
subsystems, the features available with each connection type vary slightly. Some
connection types impose limitations on Client’s features, as noted in Table 4.
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Table 4. Feature Limitations

Feature

Connection

Type

Create virtual

disk

Delete virtual

disk

Fault Events:

Client Visual

Notification

Fault Events:

Paging

Notification

Windows NT

and Windows

2000 Fault

Events: Event

Logging

Email

Notification

(UNIX/VMS

only)

Local Serial

Connection

(Storage

Window

Manager and

Agent not

used)

Supported Supported Supported Not

Supported

Not

Supported

Not

Supported

Local SCSI

Bus

Connection

(Storage

Window

Manager and

Agent not

used)

Supported Supported Supported Not

Supported

Not

Supported

Not

Supported

Local

Network

Connection

(Client and

Agent

running on

the same

host)

Supported Supported Supported Supported Supported Supported

Remote

Network

Connection

(Client

running on a

PC remote

from Agent

on a host)

Supported Supported Supported Supported Supported Supported

RAS

Connection

(Client

running on a

remote PC

with a dialup

network

connection)

Supported

but not

recommende

d. Follow-up

operating

system

configuration

cannot be

performed

remotely

Supported

but not

recommende

d. Follow-up

operating

system

configuration

cannot be

performed

remotely

Supported

reliably only

while RAS

intact. Some

events may

be missed

while dialup

connection is

broken.

Supported

reliably only

while RAS

intact. Some

events may

be missed

while dialup

connection is

broken.

Supported

reliably at

host end

only. Some

events may

be missed at

Client end

while dialup

connection is

broken.

Supported
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Delayed Event Notification on RAS Connections

Visual fault notification, paging, and event logging may be delayed significantly
in situations where RAS connections are used for multiple Clients. An Agent
with multiple Clients in its client.ini file must poll each Client whenever a fault
occurs. Any Clients not currently network-connected significantly delay this
process, because Agent must wait for their connections to time out before
moving on to the other Clients.

To avoid this situation, set the notification_method parameter for each Client in
the client.ini file to “0”, to defeat event fault notification.

CLI RUN Commands

Do not issue RUN commands in the CLI Window.  Use only a maintenance
terminal connection to issue RUN commands.

Creating Partition Units across Targets or Ports

Be aware that the name you pick for a unit assigns it to a particular host bus
target. If you create a unit from free space on a device, the program forces you
use a unit name that puts the unit on the same host target as the other partitions
on the device.

On dual-port controllers, partitions on the same device that are assigned to
different host ports are not supported.

No Code Load in Multiple-Bus Failover Mode

The controller code load feature is not functional in multiple bus failover mode
for non-OpenVMS network connections. Do not attempt to update your
controller’s software in this mode.



Release Notes

AA-RFBDF-TE Page 31

Maximum Members Dependent upon Virtual Disk Type

The maximum number of members allowed in a RAID-based virtual disk is
dependent on the disk type. However, concatenated sets are now available for
JBODs, stripes and RAID 3/5 sets.

JBOD virtual disks—maximum of one member. JBODs may now be expanded
to two disks if concatenated sets are used.

Striped virtual disks—maximum of 24 members

Mirrored virtual disks—maximum of 6 members

Striped mirrored virtual disks—maximum of 48 members

Parity virtual disks—maximum of 14 members

Maximum Number of Active Connections Limited

The controller maintains a table of host port connections that can contain up to
64 named connections. Only 8 of those connections can be active (that is, “on
line”) at any time, however. Client shows only those connections that the
controller recognizes as “on line”.

Avoiding Problem Situations

In certain situations and under specific conditions, you may experience unusual
behavior with the software.  This section presents information to help you avoid
such situations and to recover from them if they occur.

Enable Read-ahead Cache Before Enabling Write-back Cache

The controller requires that read-ahead cache mode is enabled before you can
enable write-back cache mode.

Incomplete Scans Cause Connection Loss

For proper display of subsystem status, Client performs a “scan” to collect
information about your storage subsystems. The program displays scan progress
screens while the process occurs. In some, rare situations, you may experience
incomplete scans or scans that appear to hang. In these cases, the likely cause is
that Client has lost its connection with the virtual disk it was using for
communication with your subsystem.

This problem may show up with either local SCSI or network connections.

To remedy this situation, you must first restart both of your controllers, followed
by restarting Client and Agent. If the system still does not operate properly, you
must reboot your host system. If your host is running Windows NT or Windows
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2000, you must ensure that the special device driver, HSZDISK.SYS, is installed
and running properly after it is booted.

Mirrored Cache Mode Not Retained After Configuration Restore

If you restore your controller configuration from a configuration file, the
mirrored cache setting may not be properly enabled. You must restore the
mirrored cache setting manually, using a CLI Window.

Error Message on Exiting Storage Window

Under certain conditions, when you exit a Storage Window, you may experience
an “Illegal Operation Error” message. You may ignore this message.

Inappropriate Error Message on Device Delete

If you select a disk, then chose Device/Delete, a dialog box may appear, asking
“Are you sure?”. If you choose the “NO” option, the message “Nothing selected
to delete!” is displayed. You may ignore this message.

Storage Window Corruption after Making/Removing Spare Device

If you select a disk and make it a spare (using either menu or context menu
options), then remove the device as a spare, some information in the Storage
Window may be left corrupted. To reconstruct the window, you must exit the
window and open a new one.

Cache Policy Not Shown in Controller Properties Sheet

The controller cache policy may not be properly shown in the controller
properties sheet. The field may be blank. You must use a CLI Window to obtain
the cache policy setting.

Incorrect Capacity Shown in Add Virtual Disk Wizard

In some circumstances, in Step 3 of the Add Virtual Disk Wizard, if you specify
a capacity greater than the available disk capacity, an error message results. If
you back up to Step 2 of the Wizard and return to Step 3, the correct capacity is
then displayed. An attempt to move to Step 4 of the Wizard at this point,
however, results in the same error message, even though the correct capacity is
shown.

To complete your virtual disk, you must exit the Wizard and attempt to recreate
the virtual disk.

Storage Window Corruption While Deleting a Virtual Disk

In some circumstances, if you delete and confirm deletion of a RAID-based
virtual disk, a “Subsystem Connection Status” window may be displayed, and
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the Storage Window goes blank. The Storage Window may remain blank for
several seconds until the  “Subsystem Connection Status” window disappears.

Application Errors When Restarting Agent

You may experience an “application error” error when attempting to restart
Agent after manually changing the Agent configuration files. Either of the
following issues may be the cause:

The client.ini file must end with a carriage return. If any other character
terminates the file, it may cause an application error.

The storage.ini file must not end with a carriage return. If a carriage return
terminates the file, it may cause an application error.

Client Access Changes Not In Effect

After manually editing or changing the Agent client.ini file with a configurator
program, you may notice that your Clients’ access has not changed. To place
your changes in effect, you must restart Agent after editing any of the Agent
configuration files.

Reconfiguration after Controller Replacement

If you replace either of the controllers in your subsystem, you must reconfigure
your Agent storage.ini file to match the serial numbers of the new hardware. See
your Agent documentation for details on reconfiguring your storage.ini file.

Storage Window Won’t Open

If you cannot open a Storage Window from the Storage Window Manager or in
standalone mode, the client.ini ACCESS_ALLOWED parameter for your Client
is probably set to “0”, disabling Storage Window access. Use the Agent
configuration script or edit the client.ini file to enable access to the subsystem.

Configuration File Deleted on Reinstallation or Upgrade

Save a copy of the current swcc2.mdb file to another directory if you intend to
reinstall or upgrade Client. If you uninstall the program, you will delete the
swcc2.mdb file. This file contains your configuration of host systems and storage
subsystems used in the Navigation Tree.

To reinstate your current Navigation Tree configuration after installing a new
version of Command Console, copy your saved swcc2.mdb file back to the
directory to which you installed Command Console.
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Invalid Network Port Numbers during Installation

During Client or Agent installation, you may experience an error if the
installation program cannot find an acceptable pair of network port numbers.

Your Client uses Windows sockets (sometimes called “network ports”) to
communicate with its Agents. The socket numbers at the Client and Agent ends
must match for network communication to occur.

In Windows NT/Windows 2000, the socket numbers are assigned in the services
file in the \winnt\system32\drivers\etc subdirectory. In UNIX-based systems, the
socket numbers are assigned in the services file in the /etc subdirectory. In the
unlikely event that you experience a conflict with the socket numbers, you may
edit the file manually.

There are two default socket numbers, one for Command Console (4998) and the
other for the HS series Client and Agent (4999). If you are installing either
Client or Agent and these numbers are already taken by another application, the
installation program prompts to warn you that you must choose another pair.

To select another pair for Client, open the file containing the sockets in an ASCII
editor, after you have installed Client. Pick two numbers above 1023 that are not
already used in the file, and add the following two lines:

spgui            number1/tcp # StorageWorks® Command
Console
spagent          number2/tcp # StorageWorks® Command
Console

Note that the port numbers that you select must match the port numbers used by
all of the Clients to which you wish to connect your Agent.

Network Port Assignments for UNIX-Client/Server Systems

A UNIX host may use Network Information Services (NIS) to serve the services
file containing its network port assignments.

Agent must use the services file to determine which network ports to use.
Because of this requirement, you may need to configure your system so that
Agent can access the proper services file.

You have two options to prevent a conflict between the two possible locations of
the services file. See the Agent user guide for your particular Agent for more
information.
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Error on First Attempt to Make Connection

You may experience a system error such as a “Command Execution Error” on
your first attempt to make a network connection using the Storage Window. If
this happens, try the connection again, and it will succeed.

Client hangs if Virtual Disk Deleted

If Client is monitoring a particular subsystem, and you delete the virtual disk
being used to communicate with that subsystem, the program may hang. To
delete the virtual disk Client is using for communications with an Agent, you
must first reassign another virtual disk as the communications LUN, using the
Agent Configurator.

If you are using the CCL as your communications LUN, and you disable it,
Client may lose its connection with your subsystem. If you wish to disable the
communication LUN, you must first reassign another virtual disk as the
communications LUN.

Missing Tabs in Search Menu in Help

When you select the Search button in Command Console Help, Windows Help
may not display an Index or Find Tab.

To prevent this problem, delete any hidden files with a .GID extension that are in
the Command Console directory. The WinHelp engine uses .GID files to
construct the Index and Find Tabs. If the files are corrupted, the engine may not
display one or both of the tabs. Deleting the files causes the engine to reconstruct
the .GID files.

Invalid Cache Errors

Your controller module, cache module, and subsystem devices all contain
configuration information used to keep their activity synchronized. This data is
called metadata. The controller software reports an invalid cache error on the
affected controller in situations where there is a mismatch between the metadata
in the controller module and a cache module containing unwritten data. This
mismatch can result in loss of the unwritten cache data if the error is not cleared
properly.

CAUTION

Use extreme care in responding to the
Command Console invalid cache error
prompt.  If you inappropriately instruct the
program to delete unwritten cache data, you
may lose valid user data.
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Client displays a message and prompt box when an invalid cache error occurs.
You must tell the program whether or not to delete unwritten cache data as the
error is cleared. If you are not familiar with the proper treatment of unwritten
cache data, see the information in the on-line Help documentation under the
topic “Invalid Cache Errors.”

Communications Failure on Power Up with Low Batteries

If the battery in your cache is discharged when you power up the controller, the
controller may produce an invalid cache error. If you are using Client as your
controller interface at that time, the error may prevent communication with the
controller. In this case, the controller status bar in Client changes to yellow, and
the program displays a window containing error information.

To clear the error, you must exit Client and use a normal controller maintenance
terminal to issue the CLEAR ERRORS INVALID_CACHE command before
you can use the controller. See your controller documentation for instructions on
use of the CLEAR ERRORS INVALID_CACHE command.

If the battery remains low, the invalid cache error may reappear. In this case, you
can operate your controller with reduced capability, or you can change its cache
policy to get around its built-in battery protection, although at some risk to your
data. Refer to your controller documentation for details on its cache policy
controls.

After you have cleared the invalid cache error, you can use either a normal
maintenance terminal or Client as your controller interface.

Lost Connections Cause Invalid or Missing Fault Displays and Event
Logging

Client receives notification for most types of changing subsystem fault
conditions on the next monitor interval after they occur. You may experience
invalid or lost notifications in situations in which Client’s connection with its
subsystems is broken. Any Windows NT/Windows 2000 event logs that might
have occurred while the connection was broken are also lost.

If the connection between Client and its subsystems is broken for any reason,
Client may continue to display faults that are cleared while the connection is
broken. Similarly, faults that occur while the connection is broken are not
displayed at all.

To avoid lost fault indications, make sure that Client’s connections with its
subsystems are monitored and maintained. To reestablish a connection with a
storage subsystem, you must exit and restart Client.
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Broken connections can occur for a variety of reasons:

For RAS connections—It is the nature of a RAS connection that it is not a full-
time connection. Events that occur during a period when the RAS connection is
not made are not logged to Windows NT’s/Windows 2000's event logging
facility.

For serial controller connections—Bad or missing serial cable. To repair this
situation, plug in or replace the cable.

For host port SCSI connections—Bad or missing SCSI host cable, no LUNs
configured on controller on Client startup.

For network connections—Agent missing or not running, network discontinuity,
Agent not properly configured for your Clients.

THIS controller halted, reset or hung—To repair this situation, restart or replace
THIS controller.

The virtual disk being used for communications with the storage subsystem is no
longer available.

No Agent Notification Causes Invalid or Missing Fault Displays

For some types of faults, Agent does not send Client notification of changes in
status as they occur. Client displays whatever fault information it last received.
Following are three situations in which a fault can occur without immediate
display in Client:

The OTHER controller fails or is shut down.

A cache battery on either controller fails or goes low.

A cache module fails.

A fan fails.

A power supply fails.

In all of these cases, you can get current status by viewing the subsystem in
question using the REFRESH option in the View menu.

Manual Restart Required in Some Situations

In some situations in multiple-bus mode, both controllers must be restarted to
properly continue subsystem operation. Usually, the software automatically
performs this function. If only one controller in a dual-redundant pair restarts,
however, you must manually restart the other controller.
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Reservation Conflict

Agent will discard reserved LUNs from its list of devices to be statused. The
reservation conflict will be recorded for each reserved LUN in the system error
log. A notification will appear in the log for each LUN reserved. In addition to
the system’s binary error log (Tru64 UNIX), an error message will also be
recorded in the daemon.log file. An example of the error message is “Device
lunName is reserved and cannot be statused by steamd." This only applies to
Agent during its current run. If Agent is restarted without either a) releasing the
reservation or b) rescanning the bus, the reservation conflict will be recorded
again each time Agent is restarted.

For prior Agent releases, to avoid filling the binary error log, Agent must be
stopped and restarted with bus scan enabled. Agent will not record the reserved
LUN in the storage.ini file, and will not status the reserved LUN.

Multi-agent Functionality

With the current Agent and the direct SCSI connect Client, several Agents and
direct connect Clients can talk to the same controller. Only one will access the
controller at a time, with the others being blocked until the current request is
serviced. The multi-agent functionality will work with any controller with ACS
version 8.5+. This functionality is provided by the controller which the Agent
software takes advantage of.

Problems will still be encountered if running in a heterogeneous environment,
for example, running multiple agents or communicating with a combination of
HSZ70 and HSG80s. It is recommended that only one Agent be running in such
a heterogeneous configuration. The multi-agent functionality is not available in
the HPUX Agent.

Switching SCSI Modes

When switching HSG80 controllers from SCSI-3 to SCSI-2 mode, the host
system should be rebooted after the change is made. This will clear any
unclaimed SCSI-3 CCL devices from the system. Failure to clear devices can
cause erratic Agent behavior or crash the NT system (BSOD). It is also
recommended that you reboot when changing from SCSI-2 to SCSI-3 mode.

NOTE

SCSI-3 mode is not supported on HP-UX
platforms.
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Add Virtual Disk Wizard Cache Functionality

The Add Virtual Disk Wizard allows you to try to add a unit that has readahead
cache enabled while read cache is disabled. This is an invalid action. The
controller will not allow the “add unit” to execute. The result is a storageset
without an attached unit. This “orphaned” storageset may be used to create a new
unit by returning to the Add Virtual Disk Wizard and adding a unit of the same
redundancy level as the failed unit.

Ensure that you do not check Enable readahead cache if Enable read cache is
unchecked. Refer to Step four of the Add Virtual Disk Wizard.

Add Virtual Disk Wizard – Partitioned Units and Ports Functionality

The Add Virtual Disk Wizard allows you to choose a port when adding a unit
based upon a partitioned set that is different from the port of a current unit that is
using the same partition.

Ensure that you use a LUN ID that corresponds to units that have already been
used for a partitioned storageset. For example, if a unit using a partitioned set
has a LUN ID below 100 (e.g., D55), then the subsequent units should also be
below 100. Likewise, if a LUN ID is 100 or above, subsequent LUN IDs should
also be above 100.

LUN ID is set on Step 4 of the Add Virtual Disk Wizard.

NT Agent CCL Access Device Recognition

For ACS 8.5 in SCSI-3, it is possible to have multiple CCLs based on the unit
offsets. Agent picks the last of the set as the access device. The CCLs will not
appear in the disk administrator, but are visible in the registry with their port,
target, and LUN. The CCL will show as CCLp:b:t:I, each with a different target
number (port bus target LUN, e.g., CCL2:1:1:0) in the storage.ini file.

In SCSI-2, you will only get one CCL, which is presented as an offline device in
disk administrator. This CCL will show as “PhysicalDrive#” in the storage.ini
file.

Host Non-descriptive Error Message

If the host machine running the Storage Window is not in the client.ini file of an
Agent and attempts to access that Agent, a non-descriptive error message is
returned. For example, “Cannot establish communication with ‘77FORD’ ”.
[Socket message is incorrect type.]
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Multiple Connections in Controller Properties Connections Tab

When paging through more than 8 connections in the Controller Properties
window Connections tab and then pressing the Previous button to return to
previous pages, some of the host id and adapter id labels may disappear. This
will not affect functionality.

Selecting Disk Drives When Creating Snapshots

When creating a snapshot, if you select disk drives of different sizes, Storage
Windows reports the size erroneously. Storage Window adds all selected devices
together for selected capacity. The selected capacity is actually the smallest
drive, multiplied by the quantity of drives selected. Storage Windows will allow
you to proceed when you have inadequate storage selected. When you select
drives of different sizes, you should calculate the selected storage by multiplying
the smallest drive by the quantity of drives selected. If you select drives of the
same size, this feature functions properly.

Client Domain Network Server (DNS) Setup Application Error

You must ensure that your client DNS is set up correctly. In some situations,
Storage Window will get an application error if the Host of the Agent exists but
cannot be reached directly by the Client machine.

Expand Option Not Implemented

The Expand Unit option is not implemented in ACS version 8.5.

Agent Failure using Multiple Storage Windows

If the Agent fails while you have multiple Storage Windows connected to
different subsystems, you may not be able to close the Storage Window. When
this occurs, close the Storage Window by using Windows Task Manager.

10.7 Command Console Client Troubleshooting

Authorization Error when adding the Server to the SWCC Storage Window
Manager

If you receive an authorization error when you add an agent system to the
Storage Window Manager, your client system may be missing from the Agent’s
list of client system entries. If you have more than one type of Agent installed on
that agent system, the name of your client system must be on each Agent’s list of
client system entries.
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Help Files Still Appear After Uninstall

After you have uninstalled a storage subsystem Client, its help files will still
appear. Delete the CCONSOLE.GID file, which may be hidden (Windows
Explorer>View>Options>View). This file will regenerate the next time you use
the Client’s help files.

Authorization Error when adding an Agent System

If you receive an authorization error when you add an agent system to the
Navigation Tree, your client system may be missing from the Agent’s list of
client system entries. If you have more than one type of Agent installed on that
agent system, the name of your client system must be on each Agent’s list of
client system entries.

Increasing Screen Space for the Fabric Windows and Storage Windows

Run the Client on a monitor that has a minimum super VGA (SVGA) (800X600)
display resolution. The Fabric Windows and Storage Windows require a certain
amount of screen space to properly display their contents. When you use a VGA
display resolution, screen space becomes more limited. If you must use a VGA
resolution, select the Auto Hide check box in the Taskbar Properties window to
increase screen space for the Fabric Windows and Storage Windows.

Invalid or Missing Fault Displays and Event Logs

Invalid or lost notifications may occur when the client system’s connection with
a subsystem is broken. The client system receives notification for most changing
subsystem faults at monitored intervals. This means that if the client system is
no longer notified of subsystem faults, then changes to that subsystem will not
be displayed in the client system’s Navigation Tree, Storage Window (if
applicable), Fabric Window (if applicable), and Event Viewer.

For example, while client system’s connection with a subsystem is broken, you
will not receive event logs pertaining to that subsystem, except to notify you that
the connection is severed.

The following list provides the reasons for broken connections. After you have
fixed the physical and/or software problem that is listed below, you will need to
close and reopen the Storage Window pertaining to that subsystem to obtain its
latest status.

• RAS connections - Remote Access Service (RAS) connections are not full
time. When there is no RAS connection, events are not logged to the
Application Log of Event Viewer.
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• Serial controller connections - There may be a bad or missing serial cable.
To repair this situation, replace or plug in the cable.

• Network connections - Agent may be missing or not running.

• Network connections - There may be network discontinuity.

• The Agent may not be properly configured for a client system.

• If your setup includes a controller, the controller may have halted, reset or
hung. To repair the situation, restart or replace the controller.

• If your setup includes virtual disks, the virtual disk being used for
communicating with the subsystem is no longer available.

Pager Notification Continues After Exiting the Command Console Client

You may have noticed continuous pager notification in response to subsystem
faults, even though you have exited Command Console Client. This behavior is
normal.

AES runs under Windows NT and Windows 2000 as a service. It continues to
run even after you have exited Command Console Client. AES communicates
with Agents, and it activates paging when a subsystem event occurs.

To stop pager notification, stop AES. For information on how to stop AES, see
“About the Asynchronous Event Service” in Chapter 2.

Some Graphics Do Not Scale Well with Large Fonts

It is recommended that small fonts be displayed when using the SWCC Client
software on Windows NT or Windows 2000. Some of the graphics do not scale
as well when large fonts are used.

Starting Client from the Command Prompt

To start the Client with network connections from the command prompt, enter
the following at the command prompt on the client system:

\path_to_client_directory\swcc.exe -d your_host_system your_host_subsystem

Where -d your_host_system your_host_subsystem  is an optional set of
parameters that enables you to specify a system and a subsystem to start Client.

For example:

C:\>\Program Files\Compaq\SWCC\swcc.exe –d hostsystem subsystem

If you specify these parameters, Client opens with the system selected and the
subsystem displayed in the Storage Window, in the Fabric Window, or in a Web
browser. If Client is not already aware of the system and the subsystem, it adds
them to the Navigation Tree.
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10.8 Troubleshooting Connection and Access Problems

SWCC is a TCP/IP socket-based application. As a result, SWCC requires that
each node running a SWCC Client or Agent must have access to a valid hosts
file or Domain Name Service (DNS) server. The valid hosts file must include at
least the system itself and any other systems running a SWCC Client or Agent
that it will connect to.

Dynamic Internet Protocol Address Allocation Not Supported

SWCC will not work properly if the client systems or agent systems are
obtaining an IP address dynamically. This is because the Dynamic Host
Configuration Protocol (DHCP) is not supported. RAS servers and IP tunneling
servers are supported only if they are configured to non-dynamic IP addresses.

WINS Not Supported

Windows Internet Name Service (WINS) is a name resolution service available
for Windows NT and Windows 2000. SWCC does not support WINS. Each
system, using SWCC, must have access to either a DNS server or a valid hosts
file.

Access Denied Problem

This section covers some of the most common reasons for a Client to receive an
"Access Denied" message when it attempts to add an agent system to the Storage
Window Manager.

Client System Not on Agent’s List

The client system is probably not on the authorized client system list for the
Agent. To verify that the client system is included, view the list of client system
entries in the Agent Configuration utility. For information on how to add the
client system to an Agent’s list of client system entries, please refer to the User
Guide.

Multiple Agents

If the agent system is running multiple SWCC Agents (for example, to support
different controller types) then the client system must be authorized for all
Agents. If the client system is missing from any authorized Client list of an
Agent, then that Agent cannot be added to the Storage Window Manager.

Aliases Not Checked

When SWCC Agents scan the Client authorization list, they do not check aliases.
The entry in the Client authorization list must match that returned by a
gethostbyaddr call in the hostent h_name field. SWCC will not scan the hostent
alias list to check if an alias may match the Client authorization list.
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Entry in the Client Authorization List Does Not Match

Generally, the entry in the Client authorization list for an Agent must match
what gethostbyaddr(<client IP address>) will return in the hostent h_name field
when gethostbyaddr(<client IP address>) is executed on the Agent system. If
hosts files are not exactly the same on all systems, the h_name returned may
vary on different Agent systems.

For example:

xxx.xxx.xxx.xxx client.somewhere.com client

Returns client.somewhere.com in the h_name field, but

xxx.xxx.xxx.xxx client client.somewhere.com

Returns client in the h_name field.

In some situations, you can configure the way a system uses DNS and its local
hosts file. Please refer to your system documentation to find how your system is
configured. Some systems may be configured to do the following:

Check its local hosts file first, then go to DNS.

Go to DNS first, then check its local hosts file.

Ignore DNS even if configured.

Ignore the local hosts file.

The best way to verify what needs to be used for a Client name in the Client
authorization list is to write a program that runs on the agent system and prints
the h_name field returned by gethostbyaddr(<client IP address>). Remember the
dynamic IP address allocation is not supported.

Adding New System by Using Internet Protocol Address May Cause Client to
Stop Responding

The SWCC Client may stop responding when you attempt to add a system by
using the agent system’s IP address rather than the agent system’s node name.
This occurs when the client system does not have a DNS server configured that
knows the agent system, and the agent system is not in the client system’s hosts
file. To correct this situation, add the agent system to the hosts file on the client
system.

If you receive an "Invalid host" or "Host not known" message when you attempt
to connect to an agent system, the solution is not to try the IP address. Fix your
DNS server configuration, or if that is correct, confirm that the DNS server
knows the agent system. If you are not using DNS, make sure the agent system
is in the client system’s hosts file.
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Add New System by Using Internet Protocol Address Crashes

The SWCC Client may crash when you attempt to add a system by using the
agent system’s Internet protocol (IP) address rather than the agent system’s node
name. This occurs when the client system does not have a DNS server
configured that knows the agent system, and the agent system is not in the client
system’s hosts file. To correct this situation, add the agent system to the hosts
file on the client system.

If you receive an "Invalid host" or "Host not known" message when you attempt
to connect to an agent system, the solution is not to try the IP address. Fix your
DNS server configuration, or if that is correct, confirm the DNS server knows
the agent system. If you are not using DNS, make sure the agent system is in the
client system’s hosts file. Remember WINS is not supported by SWCC.

Running Message When Adding System to the Storage Window Manager

When trying to add a new system to the Storage Window Manager, you may
receive a message, stating "No Agent running on specified system." This
message can appear for several reasons. The error most likely occurred as a result
of one of the following:

Wrong system name was entered.

Agents were not installed on the entered system.

Agents were installed on a system that stopped functioning.

The specific Client required to support the Agents, running on the agent system,
was not installed. For example, if the agent system only has a Fibre Channel
Interconnect Agent and the client system has only a HSZ22 Client, the "No
Agent Running" message will appear.

Port names and numbers in the services file may be missing or may not match
between Client and Agent. This may occur if the default value for a SWCC port
was already in use.

To check if Client support for an Agent had been installed, look at the following
registry key:

HKEY_LOCAL_MACHINE\Software\DigitalEquipmentCorporation\Command
Console\AppletManager

You should see a series of keys for supported products.
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11.0 DOCUMENTATION ADDITIONS AND CORRECTIONS

HSG80 Array Controller ACS Version 8.5 CLI Reference Manual
Corrections

Following are the additions and corrections to the HSG80 documentation set:

CLI Reference Guide (EK-HSG85-RG.AO1/165145-001), page G-17: The
following sentence should be deleted: The controller supports a maximum of
eight units on each target.

12.0 Solution Software Kit Installation

The procedure defined in these Release Notes is the method to follow for
Solution Software installation. These instructions take precedence over those
published in the included RA8000/ESA12000 and MA8000/EMA12000 Solution
Software V8.5c for HP Installation Reference Guide.

However, you should still follow the procedure for installing the SWCC Agent
as defined in the Installation Reference Guide.

Installing the 218409-B21 (Compaq/QLA2200) Driver

1. Make sure the Compaq/QLA2200 Host Bus Adapter is correctly installed in
your system.

2. Place the CD labeled Solution Software V8.5c in your host system’s CD-ROM
drive.

NOTE: pfs_mount requires pfs_mountd and pfsd daemons to be running.

To verify these daemons are running use the following command:

#ps -ef | grep pfs

If pfs_mountd and pfsd are not listed, they can be started by issuing the
following commands at the root prompt:

#nohup pfs_mountd &

System will respond with "Sending Output to Nohup.out"

Press "enter" to return to the command prompt.

#nohup pfsd &

System will respond with "Sending Output to Nohup.out"

Press "enter" to return to the command prompt.
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3. Mount the CD-ROM by entering the following command at the root prompt:

NOTE: to find the CD-ROM device file, issue the ioscan -fnkCdisk.

pfs_mount /dev/rdsk/cdrom_device_file /mnt_directory

For example:

#pfs_mount /dev/rdsk/clt2d0 /cdrom

4. Start the installation by entering the following commands:

cd /CDROM_MOUNT_POINT

./cpqinstall

Then select number 1) Install Compaq/QLA2200 FC Mass Storage Driver
Software

For example:

#cd /cdrom

#./cpqinstall

The following menu appears:

Installation Menu

1) Install Compaq/QLA2200 FC Mass Storage Driver Software

2) Exit

Enter Choice:

Type 1 and enter.
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5. Highlight the following swpackage when it appears on the screen:

NOTE: In Terminal Mode, this message appears:

To move around in swinstall:

- use the "Tab" key to move between screen elements

- use the arrow keys to move within screen elements

- use "Ctrl-F" for context-sensitive help anywhere in swinstall

On screens with a menubar at the top like this:

|------------------------------------------------|
|File View Options Actions                   Help|
| ---- ---- ------- -----------------------------|

- use "Tab" to move from the list to the menubar

- use the arrow keys to move around

- use "Return" to pull down a menu or select a menu item

- use "Tab" to move from the menubar to the list without selecting a
menu item

- use the spacebar to select an item in the list

On any screen, press "CTRL-K" for more information on how to use the
keyboard.

In GUI mode: Just Point and Click.

BHPUX1100QLC2200

6. Select Mark For Install from the Actions menu. In the status window, the
word Yes should appear under the Marked? column.

7. Select Install (analysis) from the Action menu. The Install Analysis window
should appear.

8. When Ready appears in the Status item, select the OK button to begin the
installation procedure.

9. Select the Yes button in the dialog box for each warning that appears.

10. If the installation was successful, the status item will change to Ready. If this
is not the case, check the log file and correct any errors that occurred.

11. Select the Done button and hit enter. A dialog box will appear indicating that
a reboot is required.

12. Select the OK button and hit enter to reboot the system.


